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For questions or assistance with these instructions, contact Rolka Loube Saltzer Associates via
email at: msaltzer@r-l-s-a.com , or by mail at:

ARHCF
P.O. Box 64273

Baltimore, MD 21264-4273

I. Filing Requirements and General Instructions

A. Introduction

Arkansas Public Service Commission (“ARPSC”) Docket No. 07-062-R Order No.6 (dated
7/20/07) has repealed the Arkansas Universal Service Fund (“ARUSF”) Rules. The operations
of the ARUSF concluded by 12/31/07. The ARPSC has also adopted the Arkansas High Cost
Fund (“ARHCF”) Rules to provide support to ETCs pursuant to the provisions of Act 385 of
2007 and to defray the costs of administering the fund, including the costs of completing an
annual, independent audit.

Rule 1.01 indicates that pursuant to Act 77 of 1997 and Act 385 of 2007, the Commission has the
authority and responsibility to assess a High Cost fee upon all providers of telecommunications
services, as defined by the rules of the Commission to support State High Cost objectives, within
the state of Arkansas. Every telecommunications provider that operates or provides retail
telecommunications services within Arkansas shall contribute, on a nondiscriminatory basis, into
the ARHCF (Rule 4.01).

Rolka Loube Saltzer Associates (“RLSA”) has been selected by the ARPSC to serve as the
Administrator of the ARHCF. As the Administrator, RLSA performs all of the ARHCF
implementation, management and administration functions.

B. Who Must File

The APSC Order states that every telecommunications provider that operates or provides
telecommunications services within the state of Arkansas shall contribute, on a
nondiscriminatory basis, into the ARHCF. A telecommunications provider may recover the
amount of its contribution to the ARHCF from its intrastate retail telecommunications service
customers. Telecommunications providers include wireless telecommunications carriers but not
providers of radio paging services. The ARPSC High Cost Fund Rules are posted at the
following web site address: http://www.apscservices.info/PDF/07/07-062-r_19_1.pdf.

C. When and Where to File

The 2009 ARHCF contribution period will include intrastate retail revenues billed for the period
January 1, 2009 through December 31, 2009. Monthly worksheets and remittances must be
received by the Administrator according to the filing schedule at Attachment A “2009 ARHCF
Reporting Schedule”. Worksheets and instructions can be found on the RLSA website at
http://www.r-l-s-a.com/arkansas.
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Depending on software available on your computer and settings selected within those
programs, you may opt to choose the enhanced version of the report which works within
Microsoft Excel. A manual version is also available in PDF format. The enhanced version is
designed for use within Microsoft Excel version 2000, 2002, 2003 or 2007 and provides time-
saving calculations, validations, hyperlinks and even a button (not functional within Excel 2007)
for pre-authorized filers to send their report via email, rather than printing, signing, mailing, etc.
To complete the report using MS Excel, locate the enhanced version link at www.r-l-s-
a.com/arkansas and right-click the link. Choose to save it to your computer or network and then
open it from that location. This procedure will open it within MS Excel, rather than within a
browser window. (Not all functionality will work within a browser window.)

Upon opening the report, you may receive prompts similar to these:

Selecting “Enable Macros” will enable email functionality that will not be available if
you either have your Microsoft Excel macro security set to HIGH or if you choose
“Disable Macros”. The email function can be executed using the “Click here or
manually submit xls file to efile@r-l-s-a.com” button in Excel 2000, 2002 and 2003.

Selecting “Enable automatic refresh” at this prompt will update the rate information as well
as the carrier information contained within the worksheet and will provide additional
verification that you are using the latest rates and worksheet.

If you don’t receive the above prompts upon opening the Excel file, you may be using Excel
2007 (Vista) or you might have the security settings within Excel 2000/2002/2003 set so that
you are not offered this opportunity.

If using Excel 2000/2002/2003 and you don’t get the above prompts, follow these steps to adjust
your software to prompt you upon opening workbooks with macros and external data links:
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1. Within the Tools menu, choose Options.
2. Choose the Security tab.
3. In the lower right, choose Macro Security…
4. On the Security Level tab, choose Medium. Click OK.
5. Select the Edit tab.
6. Checkmark the option toward the bottom labled:
 Ask to update automatic links

If you cannot make the preceding adjustments within your installation of Excel 2000/2002/2003,
you can manually update the information within the worksheet. :

1. Open the ARHCF 2009 worksheet.
2. Go to the “Company Codes” tab.
3. Open the View menu, then Toolbars and if the External Data toolbar does not

have a check mark beside it, click on it, otherwise, click somewhere on the
“Company Codes” data worksheet to cancel out of the menu.

4. On the External Data toolbar, click on the Refresh All button as shown here:

If you have Excel 2007 (Vista):
Upon opening the workbook, you may see a toolbar that reads “Security Warning”. If so,

1. click the Options… button.

2. Scroll down to the Data Connection section and Click on Enable this content and
then click OK.
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D. Compliance

Carriers failing to submit an ARHCF report and corresponding assessment payment in a timely
manner are subject to a two percent (2%) monthly late payment fee (effective 26.8% APR), or
$50, whichever is greater, on delinquent payment of assessments due for each month of
delinquency. See: ARHCF Regulations, § 4.03.C. Notice of late payment will be incorporated
into statements of account distributed via e-mail (when available) to the contact designated by
the carrier to receive such notices at the end of each month for which payment is not received.
Failure of a carrier to participate in the ARHCF mechanism and pay an assessed contribution
will be considered a violation of the Commission’s ARHCF rules. See: ARHCF Regulations,
§3.06.

II. Line-By-Line Instructions for Completion of the ARHCF Worksheet

All information provided on the worksheet must typed or written with black or blue
ink. All filers are encouraged to use Microsoft Excel to complete the worksheet.
Electronic completion offers many automatic calculations and validation processes
that will save you time and prevent potential filing issues.

You can register to file your Excel report via email, without having to print, sign and
then remit a signed page. Unsigned reports received from unauthorized sources will be
rejected. To register, contact the administrator for details and approval.

Identification Information

When completing the form electronically using MS Excel, the entry of a valid ID may
automatically complete the next four lines. This will happen if an ID is entered that
matches the list built into the report. If the information automatically added to the
worksheet is inaccurate, you can edit it by simply making the needed corrections.



ARKANSAS HIGH COST FUND
2009 CARRIER REVENUE REPORT & SELF INVOICE INSTRUCTIONS

Page 5

Fill in the information as follows:

Carrier:
Line 1. ARHCF Assigned ID - The ARHCF company code, currently supplied by RLSA
and available at http://www.r-l-s-a.com/arkansas/500622.pdf, starts with AR- followed by
six digits. If you do not have a company code assignment, please visit the website link
above or contact the administrator.

If this is the first filing for your company and you have not been assigned a code, you
may indicate NEW in this block.

Line 2. Company Name – Enter the name that identifies the entity for which data is being
reported and any doing business as (d/b/a) names, if applicable. If the company name
appeared automatically but is incorrect, please note that either the ID entered on line 1 is
incorrect or the name of the company may need to be corrected to reflect an official name
change, acquisition, merger or error.

Line 3. Street Address – Enter the complete street or post office box etc. mailing address
of the carrier. Postal mail correspondence is secondary to email and this address is used
only when valid contact information is not on record.

Line 4. City, State, Zip Code – Enter the City, state and zip code for the line 3 street
address.

Line 5. Main Telephone – Enter the area code and telephone number of the Company
identified on line 1 where the Administrator may directly contact the Company. This
need not be the same number as that provided for the contact provided below and will
only be used when all contact email addresses and phone numbers fail. Do not enter the
phone number of a filing agent here.

Contact:
Line 6. Name – Enter the name of the current contact person that is responsible for
responding to any questions, including the accuracy of the report, from the Administrator.

Line 7. Street Address – Enter the complete street or post office box, etc. mailing address
where the carrier wants the contact person to receive any postal mail from the
Administrator. Postal mail is secondary to email and will only be used when a valid
contact email address is not on record.

Line 8. City, State, Zip Code – Enter the City State and Zip Code for the line 7 street
address where the carrier wants the contact person to receive postal mail from the
Administrator.

Line 9. Telephone – Enter the area code and telephone number (and extension number
when appropriate) of the contact person responsible for responding to any questions,
including the accuracy of the report, from the Administrator.
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Line 10. E-Mail Address – Enter the e-mail address of the contact person identified on
line 6. This contact will receive any statements of account, notification of issues and be
the primary contact regarding the report. If the Company wishes any additional persons
to receive copies of statements of account or other information distributed by the
Administrator via e-mail, please supply those additional email addresses.

Revenue Data Period
The Revenue Data Period indicates the applicable time period that corresponds to the
revenue data being reported. Please mark the appropriate period by filling in only one
circle. Carriers should report according to the reporting frequency assigned to them by
the Administrator. The reporting frequency is specified on each statement of account
issued by the Administrator and is based on the level of revenues previously reported.
Reports marked with a period that is not consistent with the carrier’s assigned filing
frequency are usually returned or disregarded.

When completing the report within Microsoft Excel, the heading “Select only one
period” will change to reflect the filing frequency assigned to the assigned ID entered on
Line 1. This is to assist you in selecting the correct period. A carrier’s filing frequency
may be adjusted by the administrator during the course of the year and thus it may be
appropriate to select a period that is not consistent with the assigned frequency. If there
is a question, please contact the administrator in order to avoid rejection of a report.

If you are reporting for a monthly period, please mark the circle to the left of the
corresponding month. If you are reporting for a quarterly period, please mark the circle
labeled as Jan-Mar, Apr-Jun, Jul-Sep or Oct-Dec. If you are reporting for the whole year,
please mark the single circle labeled Jan-Dec. All filings should be made after the
period concludes.

Filing Revisions:
If you wish to change a previously filed 2009 report, mark the reporting period to be
replaced, and mark the square box below the list of calendar months (labeled as “This
report replaces a previous submission”) to indicate that this report is intended to replace
the previously reported period, designated above. Please report the revenue and related
information as it should have appeared. Do not report the differences.

Revisions may be used for correction of revenues previously reported in error. When
submitting a revision, follow these same instructions being certain that the correct
Revenue Data Period has been identified and the square box below the list of calendar
months has been marked.

Projection:
Carriers assigned to the annual filing frequency are no longer to file an estimate of
revenues for the current year. Those carriers are required to file an annual carrier revenue
report by February 20th of the following year and pay the annual assessment at that time.
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True-Ups:
True-ups used to be required end-of-year reconciliations, intended to replace estimated
annual data. In 2009, carriers will not estimate revenues and make an estimated payment.
Carriers should ONLY file after the conclusion of the period.

Assessment:
Revenues entered here should be for the revenue data period indicated on the form.
These revenues are billed intrastate retail revenues and should correspond to the official
books and records of the reporting carrier except if using estimated numbers to be
reconciled to actual revenues at the end of the funding period.

Retail revenues are derived from the provision of services to end users and not to reseller
carriers. Retail revenues exclude revenues from wholesale services, unbundled local
access services, and access for the provision of long distance service.

A company purchasing a service for resale to an end-user will assess the ARHCF
assessment on revenues collected from its end-users. The wholesale company will not
include service, which it sells to resellers in its retail revenues. Services purchased for
internal use and not resold to end-users are considered retail revenues of the selling
company, subject to the ARHCF assessment.

Retail revenues include, but are not limited to, revenues from the following types of
services and charges:

 Intrastate local service, intrastate vertical services, intrastate private Line service,
coin service, directory assistance, directory listings (including charges for
additional listings and non-listed numbers), mobile service billed to end-users,
and special access service billed to end-users.

 Enhanced services and vertical features provided through a central office switch
such as call forwarding, call waiting, caller identification, and voice mail.

 Intrastate long distance services, including intercity special access billed to end-
users.

 Both voice and electronic directory assistance services.
 Revenues from comparable services billed by wireless providers to Arkansas

customers, including monthly charges, usage, roaming usage and intrastate long
distance charges. (Includes revenues from mobile cellular telephone services, and
PCS/PCN.)

 Revenues from text messaging and one way paging.
 Miscellaneous charges including: late payment charges, customer fees, and

nonrecurring and installation charges.

Retail revenues do not include revenues derived from the following types of services and
charges:

 Local, state, and federal taxes.
 Interstate long distance and special access services.
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 Federal USF payments.
 Support payments from ARHCF.
 Federal local number portability (LNP), primary inter-exchange carrier charge

(PICC), or federal USF Line charges.
 Ring tones, games, songs, video or similar media downloaded to a wireless phone

or computer, usually billed on a per click basis without a separate
telecommunications charge.

 Warranty or Service agreements on a wireless device.
 One time or monthly recurring charges for premium web content. The premium

content is usually a better version of a free site.

 Revenues in this section should be reported in whole dollars using half rounding.
For example: $488.505 would be rounded to $489 and $488.494 would be
rounded to $488.

Line 11 –Intrastate Retail Revenues Only
In the first shaded box, insert the figure for the carrier’s total billed intrastate retail
revenues that are assessable for ARHCF purposes. When completing the report within
Excel, the amount entered will also be displayed in the rightmost shaded box. When
completing the worksheet using another method, please also enter that amount in the
rightmost shaded box.

Line 12 – Uncollectible Intrastate Retail Revenue Percentage - [OPTIONAL]
Insert the appropriate uncollectible revenue factor at the appropriate space on Line 12.
The uncollectible revenue factor in decimal format must have a value of less than 1.
Enter it as a decimal such that one percent would be typed into the box as 0.01 rather
than as 1. If completing the form within Excel, it will be displayed as a percentage after
moving to another cell. For example, if the company experiences 7% uncollectibles,
enter .07.

Line 13 – Uncollectible Intrastate Retail Revenues - [OPTIONAL]
If the company uses a percentage as the uncollectible, enter the product from the
multiplication of the billed intrastate retail revenue figure on Line 11 and the
uncollectible factor on Line 12. If the company prefers to use a cash value instead of a
percentage, enter the uncollected intrastate retail revenues into the leftmost shaded box
(as a positive number). It is considered to be a deduction relative to the amount of
Intrastate Retail Revenues.

When completing the worksheet within Excel and a percentage was entered on line 12,
the product will be automatically calculated for you and copied over to the rightmost
column as well. When completing the worksheet by other means, please also enter the
same value into the rightmost column.

Line 14 – Revenues Subject To Arkansas USF Assessment
The uncollectible intrastate revenue amount on Line 13 is subtracted from the total billed
intrastate revenue figure on Line 11. The resulting amount is to be entered on Line 14.
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This amount is the reporting carrier’s intrastate retail revenues that are subject to the
ARHCF contribution assessment.

Line 15 – Applicable Assessment Rate
The assessment rate(s) can be located on the website www.r-l-s-a.com/arkansas. Insert
the decimal rate corresponding to the period being reported. Seven tenths of a percent
would be typed into the box as 0.007 rather than as .7. If completing the form within
Excel, it will be displayed as a percentage after moving to another cell.

When completing the worksheet within Excel, the assessment rate may fill in
automatically based on the reporting period selected. If “Invalid worksheet” appears in
this box, this worksheet cannot be used to report revenues for the selected period due to a
change in the assessment rate during the selected period. Please visit the website www.r-
l-s-a.com/arkansas for the appropriate dual column worksheet, contact the administrator
or select a shorter reporting period.

Line 16 - Gross ARHCF Assessment
If prepared within Excel, the report automatically multiplies the amount appearing on
Line 14 by the ARHCF assessment rate as indicated on the worksheet on Line 15,
otherwise, you should perform the multiplication and enter the result on Line 16. If
[Choose Period] appears on this line, select the reporting period being reported before
continuing.

Remit:
Line 17 – Estimated Late Payment Penalty
ARHCF remittances are due on or before the due date. Assessments not received by the
scheduled due date are subject to a two percent (2%) penalty (minimum charge of
$50.00) per monthly cycle of delinquency, e.g. if the assessment is $200 and is received
on the 28th, a $50 penalty is assessed. If the assessment is $5,500, then a $110 penalty is
assessed per month. Enter the appropriate figure on Line 17 as a positive number. If
completing the report within Excel, an estimated late payment charge will be calculated
for you based on later of the date when the report is being completed or the entered
signature date. The estimate will not reflect delays in arrival, existing account credit or
fund support payments due to the carrier. An explanation of the calculated penalty will
also appear on this line.

Line 18 – Outstanding Debt, (Credit) or (Fund Support Amount)
Enter any outstanding debt as a positive number or unused credit as a negative number.
ILECs who receive support from the fund should enter the expected net support as a
negative number. If this report is replacing a previous submission for the same period,
enter a credit for the previously reported Gross ARHCF Assessment.

Line 19 – Total Remittance Due
Add the amounts from line 16, 17 and line 18 and enter the sum on this line. If the sum is
less than $1.00, enter $0. If prepared using Excel, the worksheet will automatically
calculate this total. If the result is positive, this represents the net ARHCF remittance to
be paid to the ARHCF.
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Certification:

Line 20 – Date, Authorized Signor Name, Signature, Title
Enter the signature date, name and title of the person who is signing the report. The
signor’s signature attests to the accuracy of all information submitted on the remittance
worksheet.

Unsigned reports will not be accepted unless preapproval is acquired and the Excel report
is submitted by an approved email address, in xls format, to msaltzer@r-l-s-a.com.

Worksheet Submission and Payment Method

At the top of the worksheet and within Attachment B to these instructions, please take
note of several ways to contact the Administrator.

Where to File
Signed reports with a remittance due should be submitted to the ARHCF lockbox at the
address on the bottom of the worksheet. If no remittance is due, signed worksheets may
be faxed to (717) 231-6667 or scanned and e-mailed to efile@r-l-s-a.com. Preapproved
filers may submit the Excel xls file via email. Please only send a report by one method.
Please do not send the report by email, then again with a check. Reports received by the
administrator by email will be acknowledged with an email response.

If a payment is made, please include the assigned ID on the check, stub or electronic
payment request’s memo/description field.
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Attachment A

ARKANSAS HIGH COST FUND

2009 ARHCF Reporting Schedule

INTRASTATE RETAIL REVENUES BILLED
FOR THE PERIOD

REPORT AND REMITTANCE DUE TO
ARRIVE ON OR BEFORE

Monthly Reporting
January 2009 February 20, 2009
February 2009 March 20, 2009
March 2009 April 20, 2009
April 2009 May 20, 2009
May 2009 June 19, 2009
June 2009 July 20, 2009
July 2009 August 20, 2009
August 2009 September 21, 2009
September 2009 October 20, 2009
October 2009 November 20, 2009
November 2009 December 21, 2009
December 2009 January 20, 2010

Quarterly Reporting
January through March 2009 April 20, 2009
April through June 2009 July 20, 2009
July through September 2009 October 20, 2009
October through December 2009 January 20, 20010

Annual Reporting
January through December 2009 February 20, 2010

Signed reports can be sent by mail to: ARHCF
P.O. Box 64273
Baltimore, MD 21264-4273

Or by courier to: ARHCF
M&T Bank Lockbox 64273
8th Floor
1800 Washington Blvd.
Baltimore, MD 21230

Phone (410) 347-6245

Or by fax to: (717) 231-6667

Or by email to: msaltzer@r-l-s-a.com

Please choose only one method for delivery.
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Attachment B

Arkansas High Cost Fund

ARHCF Payment and Worksheet Submission Information

Payments may be made by check or transmitted via electronic funds transfer. If paying by
check, please ensure that the assigned ID appears on the check or stub. Payments should be
transmitted as follows:

For Regular Payments by Check:
ARHCF
P.O. Box 64273
Baltimore MD 21264-4273 Please make payments payable to:

ARHCF and include the assigned ID

For Overnight Payments by Check:
ARHCF
M&T Bank Lockbox 64273
8th Floor Please include the ARHCF assigned ID,
1800 Washington Blvd. to assure that your payments are posted
Baltimore, MD 21230 correctly.

Telephone: (410) 347-6245
RLSA’s Taxpayer Identification Number

For Electronic Funds Transfers: (TIN): 30-0410008

Fedwire
Identify the transmittal as: If paying by Electronic Funds Transfers
“ARHCF Payment” please also send a fax or e-mail to the
Bank: M&T Bank (ATTN Agent Banking) Administrator indicating the date and
ABA #: 022000046 identifying any amounts involved in the
Account #: Lockbox #64273 (Checking transfer to insure proper credit to your

Account 9835178659) Account(s).
Acct Name: Arkansas High

Cost Fund
ACH

Identify the transmittal as:
“ARHCF Payment”
Bank: M&T Bank (ATTN Agent Banking)
ABA #: 052000113
Account #: Lockbox #64273 (Checking

Account 9835178659)
Acct Name: Arkansas High

Cost Fund

If you need additional information, please contact ARHCF Administration at (717) 237-6748.

For ABA and account
information, please
contact us.


